Editor’s Notes

About Our Contributors

Video Tutorials: Larry Jordan shows how to create motion path keyframes with Bézier curves and control points.

Bonus Video Tutorial: Larry Jordan shows how to add keyframes and Bézier control points to other motion effects and filters.

Exclusive Audio Profile: Edit Well interviews Thomas Porett on how he uses Final Cut to create video as electronic art.

Keyboard Shortcuts: LiveType

Exclusive Audio Profile: Rick Lavon tells Edit Well how XML improves his production workflow.

Comparing Keyframes Between Applications

Bézier Curves

Keeping Colors Broadcast-Safe

AKA Media Mangler

Comments from Rick Lavon

2006 Edit Well Index

Creating Animation with Keyframes in Final Cut Studio, Part 1 —Mark Spencer

Keyframes are the core of all animation. In the first of two articles, Mark Spencer illustrates how to create powerful animation effects in Final Cut Pro using keyframes.

Chroma-Keying for Action Films using Final Cut Studio —Kevin Monahan

Pulling a great-looking key is part art and part technique. In this article, Kevin shows how to create keys in Final Cut and Motion and explains when to use which program.

The Secret Life of the Color Picker —Larry Jordan

Beneath its mild-mannered exterior lurk some amazing features. Larry Jordan exposes the Color Picker you never knew.

Media Manager: Friend or Foe —Tom Wolsky

Final Cut’s Media Manager has a nasty reputation. Tom Wolsky walks you past the pitfalls and illustrates how to put Media Manager to work for your projects.

XML Techniques for a Faster Workflow —Andreas Kiel

XML is not for the newbie. But if your deadlines are way past ridiculous and change is an everyday affair, manipulating your project in XML can make the difference between getting it done and giving up.
I’m writing these notes the day after Macworld in San Francisco—a fabulous event if you like phones, somewhat underwhelming if you like new software.

Still, even if Apple didn’t have anything new at Macworld (iPhones don’t go on sale until June), we do! Starting next month, we’re adding a new feature called “Tell Us Your Story.” This is a series of first-person articles showcasing how you use Final Cut Studio. (Click here to get the details.) And we’re putting our money where, um, your mouth is—we’ll pay $100 for every story we publish.

This new series premieres next month with an article written by Jody Eldred on how he’s importing and editing XDCAM video in Final Cut. We’re delighted that Jody is sharing his expertise with us, and we look forward to printing other editor’s stories in the future.

I received a number of email comments expressing concern about something I wrote last month, when I said that we’re expanding our focus to include After Effects. Fear not—we’re not losing sight of Final Cut Studio. It’s just that all of us use lots of different software in our editing, and we felt that it would be appropriate to discuss ways in which we can get everything to work together. For that reason, you can also look forward to articles on After Effects in future issues.

Also, in answer to another letter, our current editorial philosophy is that Edit Well is not a forum for testing or reviewing new products. Rather, we view our role as providing advanced tutorials, techniques, and training on how best to use software and hardware that relates to Final Cut Studio.

This issue is a showcase for techniques that you can’t find anywhere else. I’m pleased to welcome Andreas Kiel, founder of Spherico and author of a variety of XML-based editing tools, with a piece on how you can use XML to speed repetitive editing tasks. Andreas takes on this challenging subject and actually makes it understandable.

Mark Spencer begins a two-part series comparing keyframing within Final Cut, Motion, and LiveType, discussing which application to use when creating effects. I never knew there was so much to learn about keyframes!

Tom Wolsky returns with an article on how to use Media Manager effectively to get your media under control. Media Manager can trap the unwary, and Tom shows you how to avoid problems.

Kevin Monahan presents a masterful effects article on how to chroma-key in Final Cut and Motion, and which one to use for your projects.

Finally, I explore the secret life of the color picker—that ubiquitous dialog box that helps us select colors—and show how to use it to keep your colors broadcast safe.

We also have two great video tutorials and two fascinating audio profiles; be sure to take the time to listen to all of them.

If you have story ideas, please send me an email message outlining what you’d like us to cover. And if you’re interested in writing for Edit Well, I’d like to hear from you.

See you next month—and, in the meantime, edit well.
About Our Contributors

Mark Spencer
Mark Spencer is a freelance producer, editor, teacher, and author working in the San Francisco Bay Area. He is an Apple Certified Trainer for Final Cut Pro, Motion, and DVD Studio Pro, and the author of *Motion for Mac OS X: Visual QuickStart Guide* from Peachpit Press. Mark maintains the Motion-dedicated site applemotion.net, and he can be reached at mark@daystreet.com.

Andreas Kiel
Andreas Kiel is the president of Spherico, a German-based company specializing in film effects and tools for the professional editor. Andreas began working on a Mac as an illustrator 25 years ago. He has used Adobe After Effects and Adobe Premiere since their initial releases, and regularly writes about the software. After moving to Final Cut Pro for editing, Andreas trained Apple’s German-speaking marketing and sales staff. He developed the first high-resolution multi-head panoramic video camera. Andreas has also developed a series of XML tools for use with Final Cut Studio. Visit his website at: www.spherico.com/filmtools/.

Larry Jordan
Larry Jordan is a consultant and Apple Certified Trainer in Digital Media with more than 25 years’ experience as a television producer, director, and editor with national broadcast and corporate credits. Based in Los Angeles, he’s a member of both the Directors Guild of America and the Producers Guild of America. Larry has also been recognized as one of the Top 100 Corporate Producers in America. He has written two books on Final Cut: *Final Cut Pro HD Hands-On Training* (Peachpit, 2004) and *Final Cut Pro 5 Hands-On Training* (Peachpit, 2005). Visit his website at www.larryjordan.biz.

Andreas Kiel

Kevin Monahan
Kevin Monahan is a video editor and motion graphics artist living in San Francisco. He is the president and co-founder of the world’s first FCP User Group, SF Cutters. Kevin has worked on projects at such companies as Apple, Electronic Arts, and Pixar. He is also the author of *Motion Graphics and Effects in Final Cut Pro* (Peachpit, 2004). Visit Kevin’s website at www.sfcutters.org.

Kevin Monahan

Tom Wolsky
Tom Wolsky is a former ABC News producer and operations manager in London and New York. He now has a boutique production company in northern California and has been teaching Final Cut Pro since it came out. He teaches for Digital Media Academy and has written a number of books, articles, and DVDs on Final Cut Pro, Final Cut Express, video production, and video journalism. Visit his website at www.SouthCoastTV.com.

Tom Wolsky

Kevin Monahan

Mark Spencer

Andreas Kiel

Larry Jordan

Kevin Monahan

Tom Wolsky
Tips to Successful Log and Capture  —Tom Wolsky
Learn ways to improve the process of getting media into Final Cut.

Creating Effects with Motion’s Replicator  —Mark Spencer
Go behind the scenes of one of the powerful new features in Motion—the Replicator—and learn how to create some fascinating geometrical effects.

Setting Up an XDCAM Workflow  —Jody Eldred
Discover how to get media from XDCAM, a tapeless Sony video format, into Final Cut for editing.

Dazzling LiveType Effects  —Kevin Monahan
See some spectacular LiveType effects and animations that you can put to use in your own projects.

Plus part 2 of Mark Spencer’s keyframing article and as many tips, techniques, shortcuts, interviews, and video tutorials as we can stuff into one issue!
Creating Animation with Keyframes in Final Cut Studio

This two-part series focuses on the process of creating animation with keyframes in three different applications that are part of Final Cut Studio: Final Cut Pro, LiveType, and Motion. We'll look at the benefits and drawbacks of each option so that, the next time you want to create an animated opening title for a show, move arrows to explain a chart, perform a fancy lower-third for an interview subject, or work on a complex project combining video and animated elements, you’ll have a sense of the best tool for your job.

In this first article, we look at keyframing in Final Cut Pro.

If you’re a visual storyteller and use Final Cut Studio, you have a deep and extensive toolset at your disposal. So deep and extensive, in fact, that the same storytelling goal can be achieved in many different ways—and with several different applications.

What's a Keyframe?

In Final Cut, keyframing is the process of creating animation by setting fixed values for a parameter at two different points in time, so that the software calculates the value change between the two points. I know, the description sounds quite vague, but this broad definition is the real power behind keyframing—it can be applied to a wide variety of attributes connected to all kinds of objects and effects.

For example, suppose you want to move a simple circle from the left side of the screen to the right side over the course of one second (to reveal a title, perhaps). You would set one keyframe for the position parameter to fix its value at the left side of the screen; then, one second later, you would set a second keyframe for the same position parameter with a new value that places the shape at the right side of the screen (see Figure 1). The computer has been instructed that the shape needs to move from the left to the right between the keyframes, so it interpolates new position.

Mark Spencer

Watch as Larry Jordan illustrates many of the concepts in Mark Spencer’s article on keyframing. Discover for yourself how Bézier curves can take a simple motion effect and make it extraordinary. Click here to play. (TRT: 8:09 13.1 MB)
values for every frame between the keyframes—and the result is a simple animation.

Keyframes can be applied to objects (such as video, graphics, text, and generators) and to effects (such as filters and masks).

Let’s consider another example. Say you want the background of a video clip to get progressively blurrier over time, in order to draw attention to the title in the clip. In Figure 2, a Gaussian Blur filter is applied and keyframed with a value of 0 at frame 0 and a value of 50 at frame 30, so that the image grows blurrier over the course of 30 frames, drawing attention to the text.

That’s the basic concept. By applying multiple keyframes to various parameters of objects and effects, you can create sophisticated and elegant animations.

While we can create animation effects in Final Cut Pro, LiveType, and Motion without using keyframes, the precise control that keyframes provide often makes them the tool of choice to create a specific effect.

The basic process for setting keyframes is the same in all three applications: Move to a point in time, set a keyframe, move to a different point in time, set another keyframe. Lather, rinse, repeat.

Now we’ll look at how to use keyframes for specific activities in Final Cut Pro.

Keyframing in Final Cut Pro

You can animate just about anything with keyframes in Final Cut Pro:

- Position, rotation, scale, and opacity of any object, whether it’s video, graphics, text, or a generator
- Points of a mask
- Attributes of just about any audio or video filter

To set keyframes for an object in your Final Cut Pro Timeline, such as a video clip or a graphics file, follow these steps:

1. Load the clip or graphic into the Viewer, and then select the Motion tab. Every parameter listed on the Motion tab can be keyframed—including the Basic Motion, Crop, Distort, Opacity, Drop Shadow, and Time Remap categories.

2. Move the playhead to the frame where you want the animation to start, and click the Ins/Del Keyframe button (see Figure 3).

Figure 3: To create or delete keyframes, click the diamond-shaped Ins/Del Keyframe button. To move between keyframes, click the left- or right-arrow button.
3. Move to the frame where you want to establish a new value, and adjust the slider (or enter the value).

**Note:** Once you set one keyframe, new keyframes are set automatically when you change or enter a new value at a new point in time for that parameter.

When working with keyframes in Final Cut Pro, it can be helpful to enlarge the Viewer. You can even drag the Motion tab from the Viewer into the Timeline, giving you a nice big view of the keyframe editor (see Figure 4).

**Adjusting and Moving Keyframes**

Once you’ve set a keyframe, you can adjust it by changing its value or moving its location in time. Before adjusting the value of a keyframe, however, make sure that the playhead is parked directly on the keyframe, or you’ll accidentally...
create a new keyframe. Use the little gray arrow buttons on either side of the Ins/Del Keyframe button to jump between keyframes. The Ins/Del Keyframe button displays a green center if the playhead is parked on a keyframe.

To move between keyframes, press Shift+K to jump forward or Option+K to jump backward. These keyboard shortcuts are the same in Final Cut Pro, LiveType, and Motion.

One handy feature in Final Cut Pro is the ability to set keyframes quickly for some of the basic Motion tab parameters (Basic Motion, Crop, and Distort) by clicking the Add Motion Keyframe button at the bottom of the Canvas, or by pressing Control+K (see Figure 6). Don’t worry about setting keyframes on parameters you don’t want to animate—as long as you don’t change their values, the keyframes won’t actually do anything.

You can adjust how the application interpolates values between the keyframes. For most keyframes, you can right-click or Control-click the keyframe in the keyframe editor and choose Smooth or Clear (see Figure 5). Choosing Smooth slows the animation as it enters or leaves a keyframe, which can be very useful for creating realistic-looking position and scale changes. (Adjusting the Bézier handles provides even more control—see the sidebar “Bézier Curves” for details on how to use the handles.) Clear deletes the keyframe.

Center keyframes, which control image position, must be smoothed in the Canvas rather than in the Motion tab of the Viewer.

Keyframes for Filters and Motion

Keyframes and Bézier control points can be applied to more than motion paths. Here, Larry Jordan shows you how to apply Bézier curves to video filters and Motion tab settings, to add elegance and control to your effects. Click here to play. (TRT: 4:19 7.1 MB)
For example, apply the Ripple filter to some text, load the text in the Viewer, click the Filters tab, and then set keyframes for the Amplitude parameter—one at zero, and one a few seconds later at a higher value—so that the text starts out normally and then animates to become more and more rippled over time (see Figure 7).

The text animation possibilities with keyframes in Final Cut Pro are practically limitless. Try using the Boris > Title 3D text generator to create some text, add it to the Timeline, load it back into the Viewer, and click the Controls tab. Every darn parameter in there can be keyframed (see Figure 8)!

Caution: You can really go to town animating text in Final Cut Pro—but it takes some time to experiment, and you’ll need to render to see your work.
In addition to the keyframe editor view in the various tabs of the Viewer, you can view and modify keyframes directly in the Timeline (see Figure 9).

1. Make the Timeline active, and then click the **Toggle Clip Keyframes** button at the bottom left of the Timeline (or press Option+T). Final Cut displays a blue bar under any clip that has Motion tab keyframes, and a green bar for Filters tab keyframes (see Figure 10). Sorry, no Controls tab keyframes are visible here.

2. To select which keyframes to affect, right-click or Control-click the gray area under the clip.

3. Click and drag the desired keyframes to move them in time or change their values. Clip markers can also be useful in aligning keyframes.

**Figure 8 (left):** A partial view of the keyframable parameters for text created with Title 3D.

**Figure 9:** Click the **Toggle Clip Keyframes** button to edit keyframes in the Timeline.

**Figure 10 (above):** Viewing keyframes in the Timeline. The green bar represents clips with filters; the blue bar is for clips with motion properties. The dots in each bar indicate where keyframes are located.
If you turn on the Time Remap property to create variable speed changes in a clip, you’ll have access to a full graph for keyframing time-remapping directly in the Timeline (see Figure 11). To set keyframes for this property, hold down the Option key while clicking the graph with the Arrow tool, in the Timeline or on the Motion tab of the Viewer.

**Keyframing in Final Cut Pro: Pros and Cons**

Final Cut Pro’s process for creating animation through keyframes is powerful and flexible. If you’re already working in Final Cut and you want to animate some text, a shape, or a filter applied to video, it’s convenient to be able to continue to work in the same application. For simple animations, this workflow is probably the fastest and easiest. There are a few downsides, however (see the table “Comparing Keyframing Between Applications”). For example:

- Many keyframed animations require rendering in order to view them in real time. If you’re creating detailed, precise animations, the process of tweaking, rendering, and viewing can become tiresome.

- If you’re looking for precise adjustment of keyframe interpolation, you may find Final Cut’s Bézier handles a bit difficult to work with—especially if you’re trying to match animations of both position and scale, such as panning and zooming on photographs. You might find it difficult or downright impossible to create a smooth start or stop.

- If you’ve ever attempted to keyframe a garbage matte to hide or isolate an object moving in the frame over time in Final Cut, you know that it can be a tricky process.

- Although text animation possibilities are extensive in Final Cut Pro, the process for creating them can be a bit tedious. If you’re interested in more information on keyframing and other effects-creation tools within Final Cut Pro, check out Kevin Monahan’s excellent book *Motion Graphics and Effects in Final Cut Pro* from Peachpit Press.

Thankfully, Final Cut Studio offers some excellent keyframing alternatives in other applications—LiveType and Motion—which I’ll cover next month in the conclusion of this series. *EditWell*
# Comparing Keyframing Between Applications

<table>
<thead>
<tr>
<th>APPLICATION</th>
<th>PRO(S)</th>
<th>CON(S)</th>
<th>WHEN TO USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final Cut Pro</td>
<td>• Full-featured keyframing and compositing inside the software</td>
<td>• Rendering is often required&lt;br&gt;• Bézier handles are difficult to control when matching parameters&lt;br&gt;• Text animation can be tedious</td>
<td>• Simple opening titles, lower thirds, animated masks&lt;br&gt;• Animated filters (blurs, color correction)&lt;br&gt;• Animated graphics (multi-layered PSD files, generators, multi-layered compositing)&lt;br&gt;• Animated still-image movement</td>
</tr>
<tr>
<td>LiveType</td>
<td>• Powerful text animator&lt;br&gt;• LiveFonts&lt;br&gt;• Tweekeyable preset text animations&lt;br&gt;• Ability to keyframe individual words and letters&lt;br&gt;• Animated glyphs for graphical elements and masks&lt;br&gt;• Library of background content and templates allows for complete motion graphics production</td>
<td>• Requires RAM preview&lt;br&gt;• Working with non-text objects (video, graphics, shapes, mattes) can be cumbersome&lt;br&gt;• Keyframing multiple parameters requires lots of mouse clicking and manual entry&lt;br&gt;• Keyframes cannot be synced to audio</td>
<td>• More complex title sequences and lower thirds&lt;br&gt;• Anything that requires precise animation of individual words or letters&lt;br&gt;• Simple DVD menus&lt;br&gt;• Templates that have been modified for quick show openings and lower thirds</td>
</tr>
<tr>
<td>Motion</td>
<td>• Real-time performance&lt;br&gt;• Records or sets keyframes manually or automatically&lt;br&gt;• Full-featured keyframe editor&lt;br&gt;• Library of content and preset animations&lt;br&gt;• Motion behaviors can be combined with keyframes&lt;br&gt;• Keyframes can be synced to audio</td>
<td>• May be overkill for simple keyframe work that can be done in FCP&lt;br&gt;• Keyframe editor can be buggy</td>
<td>• Show opens&lt;br&gt;• DVD menus&lt;br&gt;• Sophisticated, animated lower thirds</td>
</tr>
</tbody>
</table>
The Goal of Chroma-Keying

Whether you’re working in Final Cut Pro or Motion, the goal of chroma-keying is to make the blue or green areas around the subject transparent so that you can blend the foreground subject with a new background (see Figure 1). To create this effect, you place the background clip on a lower track (say, V1) and the foreground subject being keyed on an upper track (such as V2).

Chroma-keying is never easy, however, because there are so many variables. The trick in pulling a good key is that you must remove the blue or green background while preserving the edge detail of the subject. By “edge detail,” I mean smoke, hair (spiky, wispy, or blonde styles all pose unique challenges), or other “fringe.” Chroma-keying is often referred to as an art of compromises—a battle between the integrity of the matte and those elusive edge details.

Primary Keying: Choose Your Weapon

Now comes the task of choosing the application in which you will do the keying. FCP or Motion? Each application has unique advantages or workflow benefits. Each application also has more than one filter that can pull a key, so in this article we’ll just focus on the strongest tools.

Final Cut Pro’s main keying filter, the Chroma Keyer, offers good edge control as well as built-in edge thinning and softening. Its workflow is simple, as you don’t have to roundtrip to Motion to get the job done. FCP also has decent edge...
control filters and more options for color correction and final compositing than Motion currently offers. While keying in Final Cut Pro requires a lot of steps in order to pull a decent key, they go quickly once you know them.

Motion has one main advantage over Final Cut: a speedy workflow. Knocking stuff out with the Primatte RT filter is quick and easy because you can loop the footage as you adjust it (see Figure 2). However, Motion doesn’t have great edge or feathering controls, and it requires a roundtrip back to Final Cut in order to do a simple key.

Third-party filters for keying exist for a reason. They offer more advanced features than the native Final Cut Studio filters, such as light wrap, blurring, shrinking, and other blending capabilities. (From my point of view, the ultimate third-party “filter” would be Shake 4, because one of its specialties is keying.)

Garbage In, Garbage Out: Quality Is Important
The most important thing you can do to improve your chances of pulling a good key is to ensure that the image is acquired at the best possible quality. Quality can be controlled both at the shoot and in the capture process.

Regarding the shoot: If you have control of the format, avoid shooting in DV, HDV, or HDCAM. While those formats are appropriate in some instances, a green screen shoot isn’t one of them. Formats that work better for keying include DVCPRO50 and Digital Betacam for SD, and HDCAM SR for HD. For either SD or HD, a direct, uncompressed feed from the camera head, recorded to your computer uncompressed through a capture card, is always best.

Editor’s Note: There is a debate on where DVCPROHD fits on this list. While providing far better image quality than HDV, DVCPROHD is highly compressed, which can generate significant edge problems.

Regarding capturing: If the image was acquired at a high quality (such as uncompressed HD), you should capture the image at its full quality in an uncompressed codec. You may need a RAID and a capture card to support these formats. In all cases, the quality and evenness of the background screen and lighting are essential to getting a good key and often outweigh the video format when keying.

Evaluating the Image
The first thing I always do before beginning a keying job is evaluate the image and note anything that might create problems. For example:

- How does the backdrop look—wrinkled or smooth?
- Is the image evenly lit, or are there hot spots?
• Does the subject move?
• Is the subject (or anything on the subject, such as clothing) the same color as the backdrop?
• Are there any edge challenges, such as smoke or hair?
• Do separate keys need to be pulled to retain edge detail?
• Do I need any help from third-party filters?
• Should I create the key in FCP or Motion?

In the examples for this article, I’m using a shotgun image from the "Gun Stock" collection of Artbeats. This image offers its own challenges, and I’ll talk about those in just a minute.

**Mattes**

Even before you begin keying, you should roughly mask any areas of the background that you won’t need to key out. In most cases, I use a simple Garbage Matte filter for this purpose (see Figure 3). For more complex mattes, I export this duty to Motion. Keep in mind that you can keyframe the matte if the subject is moving.

**Chroma Smoothing**

Before you start tweaking sliders, consider this recommendation: Place a Chroma Smoothing filter onto your footage in Final Cut Pro before you begin keying. This filter interpolates between samples to reduce jagged edges in the key, especially if you’re forced to shoot in DV.

**Editor’s Note:** There are two Chroma Smoothing filters in FCP—one for 4:1:1 (DV) and one for 4:2:2 (SD) video. Choose the one that’s appropriate for your source. Some third-party chroma filters are superior to the FCP filters. And some keyers, such as dvGarage’s dvMatte Pro, have such chroma filters built in.

To choose the appropriate filter, select the clip and then choose Effects > Video Filters > Key > Chroma Smoothing, or drag-and-drop the filter onto the clip from the Keying bin on the Effects tab.

- For DVCAM or MiniDV, use Chroma Smoothing 4:1:1.
- For Digital Betacam, DVCPro50, or DVCProHD, use Chroma Smoothing 4:2:2.

**Editor’s Note:** The 4:2:2 filter also helps with the 4:2:0 color sampling of PAL DV and HDV in the horizontal direction. Again, third-party tools that handle 4:2:0 video can come to the rescue.
Keying in FCP

If you decide to do your key in Final Cut, start by turning off any background video by selecting the clip and pressing Control+B. Then, because filters are processed in the order in which they’re applied to a clip, add your filters to the clip in this order:

1. Chroma Smoothing filter
2. Chroma Keyer filter
3. (Optional) Spill Suppression filter (blue or green, depending on the color of the background)

Note: If you add the Spill Suppression filter before pulling the key, be sure to turn it off while you create the key, as it may destroy the edge detail you’re working so hard to preserve. It also creates a color cast of its own, which must be color-corrected anyway.

Now, open the clip into the Viewer by double-clicking the clip. Select the Chroma Keyer tab in the Viewer and pick the color of the background you want to remove, using the Eyedropper tool. To do this, follow these steps:

1. Click the Eyedropper button (called the Select Color button) on the Chroma Keyer interface (see Figure 4).
2. Select the blue or green color in the background by clicking it with the Eyedropper. Areas of blue or green should fall away.
3. If areas of blue or green remain, hold down the Shift key and click the Eyedropper once more on one of the remaining green or blue areas.

You can evaluate your key at this point. Make sure that you still have a little blue (or green) “halo” around your subject. That’s the area you want to preserve for edge detail. For fine-tuning edges, you’ll want to look at the matte you created with your Eyedropper.

Check the quality of the matte by clicking the Image View button (shown on the right side in Figure 4) to make the view display option Final, Matte, or Source (see Figure 5):

- **View Final** (red key on a silver background) is the final state you’re viewing, or the final result of your adjustments.
- **View Matte** (black key) is the matte state you’re viewing. It’s black-and-white, indicating the image’s new areas of transparency (black) and opacity (white) created by the key (see Figure 6).
- **View Source** (red key on blue background) is the clip’s original source state, so you’ll see no effect when the button is in this state.
Now that you know the different states of this button, you can check out your key to make your matte as solid as possible:

1. Click the button. The button toggles to a black key, indicating that you should be able to see and adjust the matte created by the key.
2. Locate the handle at the top of each of the Chroma, Saturation, and Luminance color strips in the interface (see Figure 7).
3. Drag each handle outward just a bit to increase the range of color values in the key.
4. Drag each of the handles at the bottom of the strips outward a bit as well.

**Note:** The top buttons control the selection. The bottom buttons control the feathering of the selection.

Inspect your work by clicking the View Final/Matte/Source button twice so that the red key appears on the button. Check it against a real background by turning on the clip’s visibility (press Control+B). Also, check it against black.

---

**Figure 6:** Inspecting the matte. White areas are opaque, black areas are transparent.

**Figure 7:** After using the Select Color button, do the following to adjust width and softness of the Chroma, Luminance and Saturation selections:

1. Drag the left "Chroma Width" handle to the left just a bit. The right handle moves in unison.
2. Drag the left "Chroma Softness" handle slightly to the left. The right handle moves in unison.
3. Drag the left Min/Width handle for Saturation to the left.
4. Drag the right Min/Width handle for Saturation to the right.
5. Drag the left "Saturation Softness" handle to the left a bit. The right handle moves in unison.
6. Drag the left Min/Width handle for Luminance to the left.
7. Drag the right Min/Width handle for Luminance to the right.
8. Drag the left "Luma Softness" handle to the left a bit. The right handle moves in unison.

As you make your adjustments, keep your eye on the matte to make it as solid white as possible. Multiple tweaks on these sliders will be necessary.
and checkerboard backgrounds in the Canvas. You can change the Canvas to checkerboard with the View pop-up menu.

You may need to make some slight adjustments to the edges of the key to improve how the subject blends in with the background. Reduce or "choke" the matte slightly by dragging the Edge Thin slider slightly to the right. Finally, feather the edge by dragging the Softening slider just a bit to the right as well. (Both sliders are shown at the bottom of the Chroma Keyer interface in Figure 4.)

**Note:** A little softening goes a long way. Use a very small amount to avoid blurring the edges beyond all recognition.

Don’t Kill Bill—Kill Spill

"Spill" is blue or green light reflected onto the subject from the background. While the Enhance slider in the Chroma Keyer will usually handle this issue for light duty, a better choice is to use the Spill Suppression filter for heavier areas of spill (see Figure 8).

Like a Matte Choker filter, a Spill Suppression filter is applied only if needed, after pulling the key. A requisite color-correction pass often will take care of color casts from spill.

Spill Suppression is great when you cannot “kill the spill.” The Enhance slider will take care of spill in the edge details only, not for color casts—which is somewhat useful, yet it doesn’t do the same job as the Spill Suppression filter. But the Color Corrector 3-way filter is often added anyway, and will do the same job with better performance.

As you can see, keying in Final Cut Pro requires a lot of steps to create a key. By contrast, creating keys in Motion is amazingly quick and easy.

Keying in Motion

If you would rather pull your key in Motion, Control-click the clip, choose Send to > "Motion" Project, and then save and name the project. Your clip will open in Motion.

Creating a key in Motion is deceptively easy:

1. Locate the Primatte RT filter in Filters > Keying.
2. Drag-and-drop the Primatte RT filter onto the clip.
You can apply a filter from the Filters button in the toolbar, or from the Filters folder in the Inspector (see Figure 9).

To adjust the key, do the following:

1. Open the Dashboard (press F7). Notice that, by default, the Output Type menu is set to Processed Output.
2. Choose Matte from the Output Type pop-up menu.
3. Adjust the Noise Removal slide to make the matte as solid white as possible.
4. Clean up any impurities in the matte, such as the softness of the edges, by adjusting the Matte Density slider.
5. Switch the Output Type menu back to Processed Foreground to make adjustments.
6. Adjust the Spill Suppression slider to take care of any residual spill.

If you need to adjust the edges of the key, you can use two filters in the Matte folder: Matte Magic and Matte Choker. I’m not a big fan of these two edge-control filters, as the FCP versions are a bit more robust. I sometimes key subjects quickly in Motion, but I do the edge work in Final Cut Pro. If you want to check out these filters, add them, and then drag them to the top of the filter stack. Otherwise, they won’t work.

Troubleshooting Keys

As I said earlier, keying is a case of compromise, and this is largely true in the case of our shotgun clip. The problem is that the image shows some detail that needs to be preserved outside of the main matte for the shotgun: muzzle flashes, shotgun shells being ejected out of the gun (see Figure 10), and smoke coming from the barrel.

If you need to adjust the edges of the key, you can use two filters in the Matte folder: Matte Magic and Matte Choker. I’m not a big fan of these two edge-control filters, as the FCP versions are a bit more robust. I sometimes key subjects quickly in Motion, but I do the edge work in Final Cut Pro. If you want to check out these filters, add them, and then drag them to the top of the filter stack. Otherwise, they won’t work.

If you have two options for this key:

1. Compromise edge quality. Find a chroma-key setting that will key out not only the shotgun, but the muzzle flash, shotgun shell, and semitransparent smoke.
2. Duplicate the footage on four layers and create a separate key for each component of the shot.

Figure 9: The Primatte RT filter in the Inspector.

Figure 10: This shotgun image poses several unique challenges, including this falling shotgun shell.
To pull off option 2, you’ll need to create separate keys for each detail. In Final Cut Pro, the process is fairly simple:

1. Stack an identical copy of the clip vertically in the Timeline for each area of concern.
2. Isolate each area with a Garbage Matte filter.
3. Apply a Chroma Keyer filter to each clip and adjust to suit your taste.

Figures 11-13 show how a wisp of smoke can be added in our gun image by applying chroma-keying to each layer.

Still need troubleshooting help? You might encounter a number of situations in which your matte needs to be tidied up with matte repair tools. For this purpose, I recommend Composite Suite from Digital Film Tools. Along with their third-party keyer, zMatte, these plug-ins are available in Universal Binary format.

Blending It Together

Usually, some color correction is necessary to blend the image with the background. Since my keys in FCP are often made up of multiple layers, the trick is to nest the layers first and then apply the Color Corrector 3-way filter to the nest. That way, you can perform a color correction to the composite as a whole.

Note: For tips on color correction in Final Cut, see the July, August, September, and October issues of Edit Well.

In Motion, I just apply a Gamma filter or Color Corrector filter to the layer to exert control over any multiple layered composites. After color correction, you might try adding a small amount of Gaussian Blur to the background clip to sell the illusion of perspective (see Figure 14).
Figure 14: In Motion, a Gamma filter is applied to the shotgun layer to darken it. A Soft Focus filter is also applied to the background to improve the apparent depth of field.

Whether you’re working with a poorly lit blue screen or some top-quality HD footage, I hope that this article has given you some useful tips about how to tackle almost any keying job, no matter what the challenge. **EditWell**

**Editor’s Note:** Another great resource for creating effects in action films is the *DV Rebel’s Guide: An All-Digital Approach to Creating Killer Action Movies on the Cheap* by Stu Maschwitz and published by Peachpit Press.

---

**Tell Us Your Story**

With a worldwide audience of Final Cut editors, *Edit Well* is looking for short, first-person stories on interesting ways (or places) that you’re using Final Cut Studio, so we can publish those stories in future issues. We’re especially interested in your thoughts on editing unusual projects you’ve taken on, and any Final Cut Studio tips you can share.

**Best of all, we’ll pay you $100**, plus give you author credit and a link to your website if we publish your story.

**The Fine Print**
- Your submission must be 600–800 words in length.
- Please use Microsoft Word (.doc) or text (.txt) format.
- Pictures or screen shots are very welcome.
- The story must be true and told from your perspective.
- By submitting the story, you grant us all publishing rights and copyrights, and you certify that this story does not infringe on anyone else’s copyrights.
- Email your stories, or story ideas, to: Editor@EditWell.com

Thanks—we look forward to reading your stories!
Bézier curves were developed by Paul de Casteljau in 1959 and named after French engineer Pierre Bézier, who popularized them in 1962 to design automobile bodies. They are now used in most computer-aided design and graphics systems that require a numerical method for providing curves and curved motions.

Final Cut Pro, LiveType, and Motion all allow you to create keyframes with Bézier handles, which you can use to control how the animation is interpolated as it moves through the keyframe. The Bézier handles control the shape of the curve as it passes through the keyframe. By dragging the handle, you change the shape of the curve. (When working with motion paths, you can also control the acceleration of the object through the curve.)

In all three applications, if you create a motion path, you'll see a series of dots along the path. The closer the dots are to each other between two keyframes, the slower the animation. Changing the length of the Bézier handles moves the dots further apart or closer together, altering the speed of the animation.

You can also “disconnect” the Bézier handles to move each side independently. One useful example is a realistic bouncing ball. When a ball bounces, it accelerates toward the ground, and then very suddenly changes direction and accelerates upward—not something that can be imitated by a smooth Bézier path. But by manipulating the handles separately, you can create a realistic ball bounce. (You can see an example of this principle in this video tutorial.)
Pity the poor, lonely Colors dialog box (generally referred to as the color picker). Taken for granted, used just long enough for an editor to get what she wants, and then, poof! Out of sight and out of mind. But the color picker has hidden options that can make your work a lot more interesting—if you take the time to look.

Color Picker Basics

The color picker is a systems-level dialog box, available to all Macintosh applications. This means that the techniques in this article apply not only to Final Cut, but to any application in which you need to control colors.

As Figure 1 illustrates, the main window of the color picker allows you to select a color; adjust its brightness and opacity; and either apply it to whatever you have selected, or store it in the color library for future use.

**Note:** Colors saved in the color library are available to all Mac applications. This feature makes it easy to standardize your colors between different applications.

Let’s start our color picker explorations by grabbing the small “thumb” in the lower-right corner, with the three diagonal stripes, and dragging the dialog box to enlarge it (see Figure 2). The advantage of enlarging the dialog box is that you gain greater control over color selection, allowing you to see subtle differences between colors more easily.
Figure 2: Resizing the color picker gives you greater control over color selection because the size of the color wheel increases. This change also increases the size of the color library.

Figure 3: To save a color for reuse later, grab the color from the color display box at the top and drag it into any square in the color library at the bottom.

You can save colors for reuse later by clicking in the color display box at the top—not in the color wheel itself—and dragging the selected color down into any color library square (see Figure 3). If the target square already contains a color, the color library will replace the existing color with the new one you dragged there.

The number of colors that you can store in the color library isn’t limited to the number of squares that are usually visible at the bottom of the color picker. In fact, the library can store 300 colors! To see them all, drag down the small gray dot at the bottom center of the dialog box (see Figure 4), and widen the dialog box, if necessary. Up to 10 rows of squares are available to store your colors, with each row containing 30 squares.

Figure 4: The color library actually contains 300 squares. To see them all, drag the small gray dot down and widen the dialog box.
To load a color from the color library into the color display box at the top of the color picker, simply click the desired color chip in the color library.

**Creating Broadcast-Safe Colors**

By default, the color picker displays colors using the RGB color space. However, in video we’re working in YCrCb color space, which is more restrictive than RGB. Here, too, the color picker can help.

> Note: While reviewing this article, Graeme Nattress added that understanding color space size is tricky. YCrCb is a transform that allows you to compress chroma resolution or achieve better perceptual compression via decorrelation. It doesn’t by itself alter color gamut. Rec. 601 or Rec. 709 RGB primaries tend to restrict the overall size of the resulting RGB color space compared to some of the best RGB color spaces, but are greater than sRGB, the common color space used for the Web, for instance.

Considering the differences between RGB and YCrCb, YCrCb is a bigger color space than video RGB. All RGB colors have a YCrCb equivalent, but not all YCrCb colors have a legal RGB equivalent. Therefore, you can generate illegal colors in YCrCb that just don’t map to a proper RGB color. The problem is that YCrCb is much bigger than RGB. The restrictions on color and white levels for broadcast come more from analog transmitter issues than from the details of the color space itself. (See the sidebar "Keeping Colors Broadcast-Safe.")

Because colors don’t move smoothly between computers and video, the only way to be sure that your colors are broadcast-safe is to use the Waveform Monitor and Vector-scope inside Final Cut.

Click the second color selector, labeled Color Sliders, to choose your colors based on numeric values (see Figure 5). Because the computer can create colors that cannot be displayed in video, such as superwhites and oversaturated yellows and blues, checking your colors against numeric values can help you to keep your colors broadcast-safe. I’ve noticed that my whites are within broadcast-safe levels if the grayscale level on the Waveform Monitor shows 93 or lower.

In the pop-up menu that appears below the magnifying glass (see Figure 6), you can select from a variety of color sliders: gray scale, RGB, CMYK (used for printing), or HSB (short for hue, saturation, brightness). For video work, the grayscale and RGB sliders are the most useful features.

The RGB sliders display color as a numerical value, where 0 is the absolute absence of the color, and a value of 255 is the maximum amount of that color (see Figure 7). To the human eye, all colors can be displayed as a combination of red, green, and blue.

> Note: Video and computer screens employ additive color, which uses red, green, and blue (RGB) as the basic building blocks of color. Printers and printing presses use subtractive color, which combines cyan, magenta, yellow, and often black (CMYK) to create colors.

While not as reliable as checking the grayscale number, here’s another trick: Colors are generally broadcast-safe if the amount of red, green, or blue doesn’t exceed 235 for any value. The problem is that both NTSC and PAL video allow greater saturation for red and cyan than they do for yellow and blue. ▶
When in doubt, use the Vectorscope or choose View > Range Check > Excess Chroma to determine whether your colors are safe to use (see the sidebar "Keeping Colors Broadcast-Safe").

There’s a hidden pop-up menu in the Color Sliders section, which you display by clicking the small color wheel icon to the left of the Color Sliders pop-up menu (see Figure 8). Theoretically, you can use the options on this pop-up menu to modify your color selection to correspond more accurately to the color space you’re using. On their own, these selections won’t make your colors broadcast-safe, but they may make your colors more accurate.

*Note:* Apple hasn’t documented what these menus actually do. They could make color choices more accurate, but only if your Mac monitor has some kind of calibration; otherwise, the color you see isn’t the color you get.
For grayscale settings, Black & White is the appropriate choice on the pop-up menu. For color, SMPTE-C is the best choice. Note that this pop-up always resets after you close the color picker, so you’ll need to follow these steps each time you want to use the settings:

1. Select the color you want to use.
2. Click the Color Sliders button and select RGB Sliders from the pop-up menu.
3. Click the small color wheel icon and select SMPTE-C from the pop-up menu.
4. Click the OK button at the bottom of the color picker to apply your selections.

There are three other color selectors in the color picker:
- Color Palettes
- Image Palettes
- Crayons

While all three are useful, especially in Photoshop work, I haven’t found them to be as helpful for video work as the selectors I’ve already described here.

**Color Picker Timesavers**

There are a number of other handy features built into the color picker. The first is the magnifying glass. With this tool, you can click anywhere on your screen—not just in Final Cut—to select the color centered inside the magnifying glass. That color will appear in the color display box (see Figure 9). To exit the magnifying glass without selecting a color, press Esc.

When you select a color by using the magnifying glass, the color picker indicates this fact by displaying a small gray triangle in the upper-right corner of the color display box (see Figure 10).
The magnifying glass is a very handy tool when you want your text to match a color in your image. In fact, Apple made the magnifying glass even easier to access by building it directly into Final Cut. You can access the magnifying glass without even opening the color picker. The magnifying glass is displayed anywhere in Final Cut that a color can be selected (see Figure 11).

![Figure 11: The magnifying glass is available whenever Final Cut has the option to select a color; in this case, I’m using Text > Controls.](image)

There are also two keyboard shortcuts that can help you fine-tune your colors: Option-drag and Shift-drag.

Display the color wheel of the color picker. Holding down the Option key while clicking in the track of the brightness slider will change the value by 2.5% up or down, depending on which direction you click. (Just to make it confusing, while the value changes by 2.5%, FCP displays the value in whole numbers.) Note that you won’t be able to drag the slider while holding down the Option key.

A second way to use the Option key is available when you display the color sliders. Holding down the Option key while clicking in any slider track adjusts that slider up or down by 1%. Again, you won’t be able to drag the slider while pressing the Option key.

![Figure 12: Holding down the Shift key while dragging the color dot constrains the color selection to move in a straight line drawn through the center of the color wheel.](image)

Here’s a final keyboard shortcut. On the color wheel, click any color; without letting go of the mouse button, hold down the Shift key. Shift-dragging a color constrains its movement to a straight line drawn between the color and the center of the color wheel (see Figure 12). The center of the color wheel is defined as the point where all colors are completely desaturated. So this technique provides a very fast way to desaturate a color without changing the hue—or to quickly find the exact opposite (complementary) color to the color you’ve selected. ▶
The Dohickey Button

One other button isn’t actually part of the color picker, but is relevant nonetheless. It’s what I call the “dohickey button,” and it’s located between the magnifying glass and the color chip in Final Cut Pro (see Figure 13).

When you click this button, absolutely nothing happens. So why is it there?

This button is useful only when you’re keyframing color changes. It controls the rotation direction of your color shift between keyframes (see Figure 14).

When you set a keyframe to change color, this button determines whether the color rotates clockwise (the default setting) or counter-clockwise. If you never use color keyframes, you’ll never need this button. In this case, I had two keyframes, the first green and the second red. Given the current setting of this button on the first keyframe, the colors would rotate from green to yellow to red. If the button were reversed, the colors would rotate from green to blue to magenta to red.

For such a small dialog box, the color picker has a lot of features packed into its space. Now that you know more about how to use it, perhaps the color picker won’t be quite so lonely in the future.

*EditWell*
For both NTSC and PAL video, the Vectorscope measures the colors in an image, showing both hue and saturation.

**Hue** is determined by where the color occurs around the circle of the Vectorscope. Red, for instance, is in the upper-left section, while blue is toward the center right. Often, hue is described as “an angle from a vertical line drawn through the center.”

**Saturation** is the distance of a color from the center of the circles shown in the Vectorscope. The farther out from the center, the greater the saturation. However, for broadcast within a YCrCb color space (the name of the digital video color space, which Final Cut Pro refers to somewhat generically as “YUV”), there’s a limit to how saturated a color should be.

Alexis Van Hurkman, author of two books on color correction in Final Cut Pro, as well as a frequent *Edit Well* contributor, adds the following: The best tip I can give is that colors with a lower brightness can be more saturated, while colors with a higher brightness must be less saturated to remain legal. One of the biggest bugaboos with broadcast legality is the “lethal” combination of high brightness with high saturation values, which overwhelm the video-engineering process of composite encoding for broadcast (cable and satellite)—hence their illegality.

Another issue is that some quality-control standards (notably PBS) demand that the maximum brightness of computer-generated titles be less than that of the maximum allowable highlights for regular video (to be specific, 90 IRE, corresponding to 90% digital). The bottom line is that titles should almost never be at maximum brightness, and they should rarely be at maximum saturation.

The easiest way to determine whether colors are broadcast safe is to make sure that no color exceeds a boundary connecting the tops of the six color targets of the Vectorscope, as illustrated here. If any color goes outside this boundary, desaturate the clip, using either the Color Corrector 3-way filter or the Desaturate filter.

To be absolutely safe, turn on **View > Range Check > Luma**, and make sure that none of your titles are triggering the green “marginal” zebra stripes. The boundary for these zebra stripes is the same as the conservative boundaries for titles.

**Note:** This is a very conservative standard, and you should always check the specific quality-control standards for your particular broadcaster.
Media Manager: Friend or Foe?

Say your drives are getting full and you want to get rid of some material that you don’t need. Or you want to move your media to a new, bigger drive. Or you’ve edited your media in low resolution and you need to recapture the material at full resolution. In Final Cut Pro, the tool you need for all these changes is Media Manager. Tom Wolsky shows how to use it.

Tom Wolsky

Media Manager has had many problems over the course of Final Cut Pro’s history, and it still has a few unresolved issues (see the sidebar “AKA ’Media Mangler’”). But for most consolidating, moving, copying, and resolution-changing activities, it works perfectly well.

Using Media Manager

Media Manager is actually easier to use than the interface makes it seem. You can choose to manage an active Timeline, or select items to manage in the Browser. Media Manager is activated by selecting the desired items and then choosing File > Media Manager, which opens the dialog box shown in Figure 1.

Editor’s Note: It’s important to always select the desired media or sequences you want to manage before you start Media Manager.
The pop-up menu at the top of the Media section of the dialog box offers a number of options (see Figure 2). The selections you make for these options in the Media section and the Project section of the dialog box control how the specified function (copy, move, recompress, etc.) operates. For instance, the default Copy function copies the selected media to a new location, which you choose by clicking the Browse button at the bottom of the dialog box.

**Management Options**

The first option in the Media pop-up, as shown in Figure 2, is **Copy**, which is the safest and least troublesome of the Media Manager functions. As the name implies, this selection copies the material to a new location. A good use for this function would be to make a copy of your existing media for a second editor to work on.

The **Move** option moves the media to a new location; for example, to a larger hard disk. Just check your media amount and your destination carefully. Make sure that you have plenty of space on the new drive to accomplish the move.

The **Recompress** option allows you to convert existing media into a new format. When this option is selected, the **Recompress media** using pop-up menu becomes active, and you can select any of FCP’s available file formats—from...

---

**AKA “Media Mangler”**

Since its introduction, every version of Final Cut Pro has seen some improvement to Media Manager—sometimes minor, sometimes pretty significant. Unfortunately, Media Manager still has issues that you should bear in mind when using this tool. Here are a few Final Cut Pro features that Media Manager has difficulty handling:

- **Double-system sound with merged clips.** This simply doesn’t seem to work properly, so Media Manager should not be used with this material.
- **Time remapping.** Works for simple functions, but the Create offline setting in Media Manager may not work correctly with some types of media.
- **Speed-changed clips.** Works for simple functions, but the Create offline setting in Media Manager may not work correctly with some types of media.
- **Freeze-frames.** Works for simple functions, but the media to create complex freeze-frames will not be capturable in Create offline mode unless performed manually.
- **Image scaling.** When going from offline to uncompressed and changing the frame resolution, this feature works correctly in some circumstances, but is problematic with motion effects.

These are the primary issues, but others may exist. It’s impossible to test every variation in FCP, especially with all the video and file formats now possible. Unfortunately, Media Manager probably never will be trouble-free until the application is based on a solid database, rather than simply on file path instructions.
Offline RT to XDCAM. This function is most commonly used for down-converting material; for instance, compressing material to Photo-JPEG in Offline RT to conserve drive space, or converting from uncompressed media to DV.

The Use existing option manages the existing QuickTime media files on your hard drive and edits them using QuickTime functionality. This is a dangerous way to manage your media. Use Move or Copy instead, if at all possible. If you just don’t have the drive space and you must work with existing media, be aware that if any failure occurs during management, the media will be lost and not recoverable without recapturing.

I strongly recommend using the Create offline function before you’ve reached the finishing stage of your program. I use it when the rough cut is complete, before any effects, motion, or fine-tuning have been done. At this stage, you should have eliminated most of your unwanted material, and you should be ready for the finishing work. Run the Create offline feature at this stage; recapture at full resolution; and do your trimming, finishing, effects, motion graphics, and animation work on the full-resolution material rather than on the offline material.

Summary Section

Before we examine the Media Manager controls at the bottom of this dialog, let’s take a quick look at the Summary section at the top of the dialog box (see Figure 3).

The Summary shows the projected results of your selections in the rest of the Media Manager dialog box. The green bars indicate how much original media is in the project (top bar), versus how much will be in the modified project after Media Manager has moved, copied, recompressed, or whatever you’ve indicated that you want Media Manager to do to the media. Notice the tail end of the Original bar, which shows the amount of space required by the involved render files. If the media is on multiple drives, the green bar will be split up to indicate how much media is on which drives. The Modified bar can vary substantially, and you should check it carefully to see if it’s producing the expected results. If you’re recompressing to offline quality, the Modified value might be very small; if you’re offlineing, no Modified bar will be shown.

Figure 3: The green bars compare the size of your original media (top) to the projected size of your media when Media Manager has finished working (bottom). The purple bar shows the size of render files.
Determining What to Manage

The options in the checkboxes in the middle portion of the dialog box (see Figure 4) can be confusing if you don’t understand Final Cut Pro terminology.

**Include render files** does just that. Most experts recommend not including render files. FCP’s links between projects, sequences, and render files are very tenuous and can get confused, as you may have experienced if you’ve worked extensively with nested sequences. Generally I recommend leaving this option unchecked and instead re-rendering your material in a new project. If you have a lot of render material, though, you might give this option a try and see whether the links are reestablished correctly. If not, you’ll just have to re-render anyway.

**Include master clips outside selection** adds master clips—clips in the Browser that are part of the project but not included in your selection—into whatever media you selected prior to starting Media Manager. Be careful with this feature, as it can add a great deal of extra material into your project. It’s a good way to consolidate media in mid-project, however; you keep everything with which you’re working, while cutting down the material you’ve already edited.

**Delete unused media from duplicated items** is a useful feature if you’re trying to cut down your project and reduce your work material. Don’t use this option if you’re simply copying or moving a project to a different location.

**Use Handles** allows you to add handles—that is, extra media before the In point and after the Out point—into the media you’ve selected. Media Manager adds whatever amount is entered in the value box, assuming that sufficient media in the original clip is stored on your hard drive.

**Include affiliate clips outside selection** uses the master clips associated with your selection and adds in any other clips affiliated with those master clips. *Affiliate clips* are made from the master clip, but haven’t been converted to master clips. If you’ve broken your material into sub-clips (which makes them master clips), or made clips into master clips for renaming purposes, you may not have affiliate clips associated with the material.
**Base media file names on** is a really useful feature. Users often capture material with generic names such as the project and reel number, or even the unfortunate Untitled, Untitled 1, Untitled 2, and so on. This pop-up allows you to change the new media name from the existing generic name of the file stored on your hard disk to the name that you specified in the Browser. The new project will be relinked to the new media and the new names, which will match the names you assigned.

The options in the Project section of the Media Manager dialog box allow you to make a new project or simply manage the media. If you deselect the checkbox for **Duplicate selected items and place into a new project**, many of your options such as master clips, affiliate clips, and multiclip angles will disappear. In most instances when you’re managing media, you’ll want to make a new project.

**Include nonactive multiclip angles** does exactly what it says. If you’re working with multiclip material and you have an angle that you haven’t actually used, you can keep it in the new project, or delete it by deselecting the checkbox.

All that’s left is to indicate the location for the new media. Click the Browse button and specify the desired location. Then begin managing your media by clicking OK in the Media Manager dialog box. A dialog box opens, prompting you to name your new project and specify the location for your newly saved project file (which doesn’t have to be in the same location where the media is being moved).

When the media-management process is done, the new project will automatically open in the Browser, and the items in this new project are connected to the new media and/or the new location of the project (see Figure 5).

The new project will include whatever sequences you selected in the original project, as well as a bin with the new master clips. Even if the clips were not master clips in the old project, they’ll be master clips in the new project. The location you specified for the media will now contain a folder called Media; inside that folder will be another folder with the new project name, containing the media you sent to it. If you manage multiple projects to the same location, all media for those projects will be put inside the Media folder, each with its own project name.

Media Manager can be a very helpful tool—as long as you understand what the checkboxes mean and you use it carefully. **EditWell**
### Keyboard Shortcuts

**SHORTCUT** | **WHAT IT DOES**
--- | ---
I | Sets In at playhead position
O | Sets Out at playhead position
Shift+I | Jumps playhead to In
Shift+O | Jumps playhead to Out
Option+left arrow | With Timeline active, jumps playhead to start of Timeline; with Canvas active, moves position of selected clip to left
Option+right arrow | With Timeline active, jumps playhead to end of Timeline; with Canvas active, moves position of selected clip to right
Command+left/right/up/down arrow | With Timeline active, moves selected track left/right/up/down in Canvas
Command+0 [zero] | Opens project properties
Command+K | Creates keyframe in the selected effect at playhead position
Control+U | Resets windows to their default layout (same as in Final Cut Pro)
Shift+Command+U | Resets blue baseline of selected track to centered, level, and flat

Apple’s LiveType manual states: “It’s important to note that the function of these options depends on which LiveType window is active. […] For example, when the Canvas is active, the arrow keys nudge the active track in small increments. However, when the Timeline is active, the right and left arrow keys advance the playhead or move it back one frame.”
XML Techniques for a FASTER Workflow

Andreas Kiel

I was asked to write an article about XML, the underlying foundation of Final Cut Pro, targeting the article toward Final Cut editors rather than programmers. That’s a little bit difficult because, for many people, XML looks a lot like programming.

I started to learn about XML with the press release that Apple sent announcing FCP 4.0. It sounded intriguing—XML might make possible some results I needed. When I first saw Final Cut’s XML, though, I was stumped, so I started experimenting with the simple Find and Replace techniques I illustrate in this article.

Note: For an additional discussion of some of the benefits of speeding your workflow using XML, listen to Rick Lavon’s audio profile on page 48 of this issue.

What You Should Know About XML

*eXtensible Markup Language* (XML) is widely used as a storage format for application documents or an interchange format between applications. It’s called extensible because anyone can create XML in his own way, as long as the generated XML follows the XML standards. This means that the XML from one program may not be the same as the XML from another program, even if they transport the same data. XML structures from different versions of FCP are different, and the XML structures of the various Pro Apps from Apple are also different. (In fact, you need an interpreter or translator to transport XML data from one application or version to another.)

The structure of XML is quite simple. Think of it like the structure of the files on one of your local hard drives: At the base level is the computer (with an OS version), on which is a drive containing folders, and then files or folders within those folders, and so on. Each file or folder also has some attributes, such as type, creation date, modification date, size, etc.

XML is intended to be human-readable. Each XML file is essentially just a text file, structured like this:

```
<something>xyz</something>
```

In XML, every node (a “container” within an XML file that holds related settings) starts with something enclosed in less-than (<) and greater-than (>) symbols. The example in Figure 1 begins with this node:

```
<article>
```

Next can come a value of some kind, a substructure of additional nodes, or nothing. The node ends the same way, except with the addition of a slash (/) after the less-than sign. Here’s how the first node ends in Figure 1:

```
</article>
```
Let’s examine the example in Figure 1 more closely. It describes the extremely short text of an article, contained within the <article></article> tags, named “About XML.” (Look for this title in the first set of <name></name> tags.)

The article consists of two numbered chapters, each of which is contained within <chapter></chapter> tags and numbered with <number></number> tags. Chapter 1 is named “About XML,” and Chapter 2 is named “What can I do with XML.” Chapter 1 is empty; its <text> tag is followed by </text>, with no intervening content. The text of Chapter 2 simply consists of one line, “Read this article.”

With some logic, and imagination, we can describe nearly anything by using XML, but a detailed XML description will absolutely be longer and more complicated than the one in Figure 1.

The example in Figure 1 uses the <name> tags twice, both for <article> and for <chapter>. The article’s name is indented one tab because it’s a child of <article>. But if we search for a tab followed by <name>, we would find all chapter names as well, since they begin in the same way as the article name. Be sure, when making searches, to include the carriage return/linefeed (CRLF) before the tab. So searching for

```
linefeed & tab & <name>
```

finds only the article name, or

```
linefeed & tab & tab & <name>
```

finds only the chapter names.

### How Final Cut Uses XML

Final Cut’s manual includes a good description about how it uses XML (see page 163), as well as some examples. What the manual doesn’t tell you is that all exports inherit their timecode settings from the current FCP project in which they reside—not from the source clip. Keep that rule in mind when working with XML. Also, time information is always expressed in frames, even if the time base differs.

FCP uses XML extensively. In fact, you can export nearly every part of a project—bins, clips, sequences, etc.—as standalone XML.

FCP’s XML looks complicated, but really isn’t if you know where to look. Figure 2 shows how the interface values of a Text generator are written to FCP XML. Note that everything in the interface has a matching entry in the XML file.
Using XML to Shift a Project Back to an Earlier Version

Have you ever needed to take a project created in a later version of Final Cut and open it in an earlier version? XML makes this type of conversion possible. Any XML-enabled version of FCP (starting with FCP 4.1) allows you to save a version 1 XML file, and the steps are very easy:

1. With the file open in FCP, select File > Export > XML.
2. In the Export XML dialog box, open the Source pop-up menu and choose Apple XML Interchange Format, version 1 (see Figure 3). Click OK. This file can then be opened in a previous version of Final Cut Pro using File > Import > XML.

Generally, this technique works flawlessly, but in some cases it may give you some unexpected results due to features missing in the previous version of FCP. For example, a multiclip created in FCP version 5 can’t be transported into FCP 4.1.

![Figure 3: To export an XML version of a project, select File > Export > XML. If you want this project to be opened in an earlier version of FCP, select XML version 1.](image)
These incompatibilities need to be resolved prior to export. It’s important to go through your project or sequences and look for any special features before attempting to export to XML. Also, look for filters that may not be available in earlier versions, or an FCP software setup (such as a capture card) that doesn’t exist on an older or different system.

Sometimes there are translation errors between versions of Final Cut Pro with audio. If you export more than two tracks of audio linked to a single video clip from FCP 5 to an XML file that you want to import into any version of FCP, none of the extra linked audio tracks can be read. The workaround is to unlink all tracks before exporting.

While these exceptions sound nightmarish, in most cases XML exporting works fine.

Note: You can even move a project from FCP to Final Cut Express—within the limitations of FCE—by using an XML version 1 export from FCP. You won’t find an Import > XML menu item in FCE. Instead, hold down the Command and Option keys while dragging the XML file onto the Final Cut Express icon. The Import XML dialog box will open (see Figure 4).

Changing an XML file

The Find function in FCP is nice—as long as you’re working in the Browser. But finding and replacing names, comments, generator text (such as titles), fonts, or whatever else appears within a sequence is a much more awkward task. However, when you export an XML file of your sequence, you can find and replace anything, since the output consists of a simple text file.

Note: Exporting to XML for the purpose of finding and replacing items is appropriate only when you have a lot of changes to make. Otherwise, you’re better off staying in Final Cut.

Let’s look at some examples. Here we’re using TextEdit, but you can use any text editor.

1. To open an XML file in TextEdit, drag the XML file on top of the TextEdit icon.
2. Once the file is open, it’s a good idea to make a backup copy. Select File > Save As and save the file with an XML extension in UTF-8 format (see Figure 5).
3. Make the desired changes in the XML file and save the file.

Figure 4: The Import XML dialog box you get with Final Cut Express looks a little different from the one in FCP.
4. To import the corrected XML file back into Final Cut, you can use File > Import > XML, but an even faster method is to drag the little icon from the XML title bar directly into the FCP Browser or on top of the FCP application icon (see Figure 6).

**Caution** Always save your FCP project before experimenting with these techniques.

**Making Global Changes**

Changing the name of multiple clips via Find and Replace is nearly the same as doing so in a normal text document—if you remember the XML structure I discussed earlier. However, while a clip name has a <name> node, many other things have a <name> node as well. How can you ensure that you'll change only clip names?

Unfortunately, you can't do it in a one-step "replace all" way, but you can use FCP's nicely structured XML to observe the hierarchy of different types of nodes, which allows you to make changes only to those specific nodes.

For example, here's how you would replace a sequence name with another sequence name:

1. Search for the first occurrence of <Sequence, and then search for the first occurrence of <clipitem (remember to type it as one word).
2. Select the text as illustrated in Figure 7. It must include the linefeed from the paragraph above, to make sure that you're selecting at the correct indentation level.
3. Copy the selection.
4. Open the Find and Replace dialog box and paste the selection into the Find field.
5. Paste the selection into the Replace field as well; then modify the actual name carefully, without disturbing the greater-than and less-than signs.
6. Use a step-by-step Find and Replace method if you want to take the safe route, or just use Replace all to change all sequence references from the old name to the new.

This example would replace all item names starting with `Sequence SDGamma2` with whatever was specified in the Replace field. To match all names that are exactly `Sequence SDGamma2`, include the less-than sign (<) in the selection. But you also could just select a portion of the phrase `Sequence SDGamma2` and replace it with something else.
Working with Generators

Changing the text in a generator presents a slightly different problem because we have to figure out the name of the node. Here are the steps to find text in a generator:

1. Search for `<generatoritem>`.
2. Scroll down until you see the `<effect>` node.
3. Select the first `<name>` entry that matches the title of the text entry in your FCP generator (see the highlighted portion of Figure 8).

Note: The first `<name>` entry is actually the name of the generator effect type (the name of the generator itself occurs a bit earlier in the file). For instance, Figure 8 shows the Outline Text generator that comes with FCP. The text from other Final Cut and third-party generators will look somewhat different.
Now that you’ve selected the search string (which can be extended as shown in Figure 9), you can change any text entry in any generator much faster than within FCP; you can even use the text editor’s spell checker to make sure that your titles are spelled correctly.

To replace some misspelled words quickly, you can use a simple Find and Replace All procedure, as long as the search string is unique. In Figure 9, for example, all occurrences of Martin could be replaced easily with Hans in just one step, since Martin is definitively not a parameter or value within FCP—though it may occur in a copyright entry.

Be careful about such global replacement procedures. Remember that "unique names" may form parts of ordinary words. For instance, the name Martin is part of the word Martinet; you wouldn’t want your chapter title "My Manager Is a Martinet" to become "My Manager Is a Hanset."

You can also replace the font in a generator. For instance, if you look at the values in Figure 9, you’ll see the font entry Gill Sans. To change the font of all text generators of the same kind, just select all the lines that belong to this <parameter> (the set of instructions immediately below the selected text in Figure 9) and paste them into both the Find and Replace fields; then change the font name as desired in the Replace field. (Make sure that the font name exists on your system.)

This technique can be used with any other parameter, although the exact text you select will differ.

You can even change all occurrences of the generator itself in a two-step Find and Replace procedure. For instance, to convert all Outline Text to Typewriter Text, follow these steps:

1. Create and modify the generator you want to use to replace an existing generator. Modifying the generator prior to export saves you from having to make changes later.
2. Export this generator as XML from your project. (Note that this technique won’t work if you created the generator using Boris Title 3D, or other Boris plugins.) This becomes your replacement generator.

3. Select all the text from the beginning of the Outline Text effect to the start of the text for the title. Figure 10 illustrates the portion of the text that you want to use for the search string. Paste that selection into the Find box.

4. Select the text in the new generator in the same way. Make that selection the replacement string in the Replace box. Then choose Replace All.

5. Now, in the original XML file, select all markup starting from the end of your actual title until you reach the end of the effect—this might be quite a long selection (see Figure 11). Make it your search string. Do the same with the new generator and make that selection your replacement string. Choose Replace All, and all your titles are modified.

Figure 10: To replace a generator quickly, you need to replace those parts of the generator in the XML that encircle your actual text entry. This trick requires a two-step approach.

Figure 11: Select all the rest of the parameters in the old generator and replace them with the new. This selection may consist of up to several pages of text.
Working with generators that allow multiple text entries requires more steps, but follows the same principles.

**Working with Filters**

Within a Final Cut sequence, you can copy-and-paste attributes to one or multiple clips, but in many cases you can’t replace the attributes. For that type of change, you need XML and a simple Find and Replace command.

Although replacing filters is similar to working with generators, the filter options are a bit more complex.

1. Find the clip with your desired settings in the XML file.

   **Tip:** Because all time references in XML are in frames, here’s a quick way to find something in an XML file. If you have your FCP project open in the background, locate the clip with the correct filter and position the playhead at the beginning of that clip. Switch the Timeline time display to Frames (see Figure 12), select the clip, and copy the value.

2. In the XML file, open the Find and Replace dialog box. Type `<start>` and paste the FCP frame value; then click Find. The search will lead you to the first track where something is starting at the given frame. You may have to use the Next button several times to find the clip you want in the right track.

3. After you find the right clip, select the text as shown in Figure 13. Don’t include the `<start>` or `<end>` values. This new selection will be used as the replacement string.

4. Now go back to the beginning of the file and use the same technique to search for the clip you want to replace. Make the text selection the same way as in step 3—this is your search string—and then choose Replace All. Another benefit of this strategy is that all your filters are kept in the same order, but the selected ones get new values.
What Else Can You Do with XML?

There are many easy things you can do in XML—such as enabling or disabling every clip (or filter). The Enable/Disable menu option in FCP just toggles clip enabling for whatever clips you have selected. With XML, you can set all items to be enabled or disabled—just search for `<enabled>FALSE</enabled>` or `<enabled>TRUE</enabled>` and replace FALSE with TRUE, or the other way around.

**Note:** Remember to be careful not to change the indenting (tabs) or the line order of the text.

In much the same way as you can replace text, you can do a lot with markers. For instance, you can copy the markers from one clip or sequence to another. Look at the XML structure in Figure 14. The marker always appears at the end of the item to which it’s assigned—if no filters are included. In the latter case, markers are placed before filters.

You can use a quick Find and Replace to convert all sequence markers into chapter markers. Here’s how:

1. Since markers are located near the end of the file, a backward Find is faster. Go to the end of the XML file and search backward for the end of the sequence, indicated by `</sequence>`. Most often, it’s visible right at the end with just a visual search.

2. From the `</sequence>` tag, go to the end of the last marker with the tag `</marker>`. It might look like the blue highlighted selection or one of the gold selections in Figure 14.

3. Markers that look like those highlighted in gold can be replaced easily in one step. Use the selection as the search string. Here’s the replacement string: `<comment>&lt;CHAPTER&gt;</comment>`

   The characters `&lt;` and `&gt;` look like hieroglyphics, but that’s how XML expresses the less-than (`<`) and greater-than (`>`) signs (It is short for "less than" and `gt` is short for "greater than"). If we attempted to use the plain text `<CHAPTER>` as the replacement string, it would interfere with the `<` and `>` of the XML tag structure.

4. Markers that look like those highlighted in blue in Figure 14 are a bit more difficult. Use the selection shown in blue as the search string. Then do a backward search from the end of the sequence and replace the comment with the following:

   `&lt;CHAPTER&gt;`

We can do the same thing with compression markers to help Compressor to do a better job.
You can also copy-and-paste keyframes from one filter to another, as long as they use the same value range, such as scale and opacity. If you animated the scale of a picture, you could animate the opacity the same way by copying the scale keyframes with just a few clicks.

By now you can probably search and play around with the XML file on your own. Just remember always to work with a copy of your XML file, rather than the original.

**Saving Filter Setups or Keyframes**

Within FCP, you can always save filter settings to your Favorites, or drag them to a bin, but in both cases it’s difficult to keep the original order or move them from machine to machine and/or project to project. Also, trashing Final Cut preferences resets all your Favorites. Here’s one last handy use for XML—creating filter sets in XML and importing them for use on other machines.

1. Create a new text generator or matte (or, if you have audio settings, use a slug) in the Timeline. Copy the clip with the effect whose settings you want to save, and paste attributes to the generator clip. I prefer to use a text generator, since I can type a description about the filter into the text field.

2. Drag the generator to the Browser or a bin, and give it a descriptive name. Generators (or bins containing generators) can be saved as XML. Make sure that you always use version 1 of XML to make your new generator backward-compatible.

3. To make use of these filter sets, import them into your current project, select the clip with the setting of your choice, and then copy-and-paste attributes to the clip you want.

I know quite a lot of freelancers who love this technique, since they can use any machine anywhere with any setup and just load their Favorites without changing the setup.

XML is the perfect tool when you want to make a lot of changes very quickly. While it can be a bit daunting at first, the time you spend studying it will more than repay you when you need to get a lot done in a hurry. 

---

**Edit Well Audio Profile**

Rick Lavon
Senior Editor, Alan Weiss Productions

Rick Lavon is the senior editor for Alan Weiss Productions in New York City. In this interview, Rick discusses how he organizes his projects to meet a weekly production deadline, the specific tools he uses, and how XML helps him get his job done. (TRT: 11:52 4.6 MB)
In this issue we profile Rick Lavon of Alan Weiss Productions. Our discussion covered the challenges of editing Teen Kids News, reasons why Final Cut handles graphics better than Avid, and how editing the XML versions of his projects helps him meet his deadlines.

After we finished our audio interview, Rick Lavon sent me the following message:

"It was a pleasure talking to you yesterday. One thing I forgot to mention was why I feel the graphics capabilities of Final Cut are so important.

Because of the scheduling limitations of the kid reporters and the studio, we try to tape 5–6 shows at once. So it sort of takes on an assembly line quality. The producers felt that trying to deal with graphics at the same time would not work, so every show is done graphics- and music-free. Everything is added in post: music, lower-thirds, over-the-shoulder graphics, full screen lists, split screens, you name it. So postproduction is very graphics-intensive, and Final Cut won hands-down over the Avid in terms of handling all these graphics quickly; and that includes graphics that are not TV-ready, such as web screen grabs and high-resolution JPEGs that I animate in Final Cut.

Finally, I find the cost of plug-ins to be cost-prohibitive in the Avid AVX format, while developers like Digital Heaven are charging something like $10 for a Final Cut plug-in. Even if it’s a one-trick pony, like the whip-pan, it’s easier to justify spending $10 than several hundred for the Avid version.

Also, here’s a list of the software I use in conjunction with editing Teen Kids News:"

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playlist2FCP</td>
<td>XML program that works well with the iTunes music library</td>
</tr>
<tr>
<td>SoundCount</td>
<td>XML program that tallies music track times (important for production music)</td>
</tr>
<tr>
<td>Boris Graffiti Keyframer</td>
<td>Standalone companion to Graffiti that creates titles without needing FCP</td>
</tr>
<tr>
<td>Sebsky Tools</td>
<td>Converts Avid media logs to FCP batch lists</td>
</tr>
<tr>
<td>Snapz Pro</td>
<td>Captures screen grabs of web pages or makes encoded videos</td>
</tr>
<tr>
<td>Automatic Duck Pro Import FCP</td>
<td>XML program that converts Avid sequences into Final Cut sequences</td>
</tr>
<tr>
<td>Photoshop, After Effects, Motion</td>
<td>Create graphics and animations</td>
</tr>
<tr>
<td>Excel</td>
<td>Imports batch list into FCP</td>
</tr>
<tr>
<td>Flip4Mac</td>
<td>Converts WMV files into QT files</td>
</tr>
<tr>
<td>iView MediaPro</td>
<td>Digital cataloging program</td>
</tr>
</tbody>
</table>
Edit Well began publishing in 2006, with seven issues containing hundreds of stories, tips and techniques. This index covers the principle contents of each issue. All 2006 back issues are available. Click here for links.
<table>
<thead>
<tr>
<th>Editor</th>
<th>Title</th>
<th>Date</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hodgetts, Phillip</td>
<td>&quot;News from NAB 2006&quot;</td>
<td>June 6</td>
<td>6</td>
</tr>
<tr>
<td>Jordan, Larry</td>
<td>&quot;FCP Attic and FCP Rescue&quot;</td>
<td>December 16</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>&quot;Match EQ Filter in Soundtrack Pro&quot;</td>
<td>December 21</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>&quot;Mixing in Soundtrack Pro&quot;</td>
<td>August 25</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>&quot;New! FCP 5.1.2&quot;</td>
<td>September 6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>&quot;STP Filters to Improve Your Mixes&quot;</td>
<td>November 29</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>&quot;Understanding Video Scopes&quot;</td>
<td>June 24</td>
<td></td>
</tr>
<tr>
<td>Kadner, Noah</td>
<td>&quot;Shooting Tapeless&quot;</td>
<td>July 6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>&quot;Removing Pulldown Frames&quot;</td>
<td>December 24</td>
<td>24</td>
</tr>
<tr>
<td>Keyboard shortcuts</td>
<td>arrow keys</td>
<td>July 30</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>controlling FCP playback</td>
<td>June 29</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>controlling windows in FCP</td>
<td>December 15</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>FCP audio levels</td>
<td>November 36</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>FCP version 5.1.2</td>
<td>November 16</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>loop preview</td>
<td>August 29</td>
<td>29</td>
</tr>
<tr>
<td>Motion</td>
<td>keyboard shortcuts</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>advanced</td>
<td>October 25</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>basic</td>
<td>September 30</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>menus</td>
<td>August 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>overview</td>
<td>September 29</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>parameter behaviors</td>
<td>October 5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>particles</td>
<td>November 6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>picking the right graphics card</td>
<td>October 27</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>real-time effects</td>
<td>October 22</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>what you need to run Motion</td>
<td>September 35</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>motion menus for DVD, creating</td>
<td>July 31</td>
<td>31</td>
</tr>
<tr>
<td>Nattress, Graeme</td>
<td>&quot;Comments on FxPlug&quot;</td>
<td>October 9</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 1)</td>
<td>July 26</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 2)</td>
<td>August 32</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 3)</td>
<td>September 31</td>
<td>31</td>
</tr>
<tr>
<td>Nazarian, Bruce</td>
<td>&quot;Great Results Using Compressor 2&quot;</td>
<td>June 20</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>&quot;Creating DVD Motion Menus&quot;</td>
<td>July 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>&quot;Creating HD Video for DVD&quot;</td>
<td>October 28</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>&quot;Scripting Stream Controls in DVD SP&quot;</td>
<td>December 27</td>
<td>27</td>
</tr>
<tr>
<td>LiveType</td>
<td>creating a movie trailer effect</td>
<td>September 8</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>moving projects to Final Cut Pro</td>
<td>September 10</td>
<td>10</td>
</tr>
<tr>
<td>Martin, Steve</td>
<td>creating a movie trailer effect</td>
<td>September 8</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>masks, great visual effects</td>
<td>June 10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>mattes, great visual effects</td>
<td>June 10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>mixing audio</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tips for setting audio levels</td>
<td>August 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>in Soundtrack Pro</td>
<td>August 25</td>
<td>25</td>
</tr>
<tr>
<td>Monahan, Kevin</td>
<td>&quot;Great Visual Effects Using Mattes and Masks&quot;</td>
<td>June 10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>&quot;Composite Modes&quot;</td>
<td>August 18</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>&quot;Pan &amp; Scan Effects&quot;</td>
<td>September 13</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>&quot;New Filter Effects in FCP 5.1.2&quot;</td>
<td>November 12</td>
<td>12</td>
</tr>
<tr>
<td>Motion</td>
<td>keyboard shortcuts</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>advanced</td>
<td>October 25</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>basic</td>
<td>September 30</td>
<td>30</td>
</tr>
<tr>
<td>pattern</td>
<td>masks, great visual effects</td>
<td>June 10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>mattes, great visual effects</td>
<td>June 10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>mixing audio</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>tips for setting audio levels</td>
<td>August 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>in Soundtrack Pro</td>
<td>August 25</td>
<td>25</td>
</tr>
<tr>
<td>Nattress, Graeme</td>
<td>&quot;Great Results Using FxPlug&quot;</td>
<td>October 9</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 1)</td>
<td>July 26</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 2)</td>
<td>August 32</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>&quot;Create Your Own Effects&quot; (part 3)</td>
<td>September 31</td>
<td>31</td>
</tr>
<tr>
<td>Nazarian, Bruce</td>
<td>&quot;Great Results Using Compressor 2&quot;</td>
<td>June 20</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>&quot;Creating DVD Motion Menus&quot;</td>
<td>July 31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>&quot;Creating HD Video for DVD&quot;</td>
<td>October 28</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>&quot;Scripting Stream Controls in DVD SP&quot;</td>
<td>December 27</td>
<td>27</td>
</tr>
<tr>
<td>online help</td>
<td>speeding up</td>
<td>September 7</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>with burned-in timecode</td>
<td>September 36</td>
<td>36</td>
</tr>
<tr>
<td>pixels</td>
<td>non-square optimization</td>
<td>September 14</td>
<td>14</td>
</tr>
<tr>
<td>plug-ins</td>
<td>Final Cut Pro (free)</td>
<td>June 16</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Final Cut Pro (for sale)</td>
<td>July 19</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>installing</td>
<td>June 17</td>
<td></td>
</tr>
<tr>
<td>Plummer, Mary</td>
<td>&quot;Soundtrack Pro Audio Cleanup&quot;</td>
<td>October 14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>preference managers for FCP</td>
<td>December 16</td>
<td>16</td>
</tr>
</tbody>
</table>
pulldowns, understanding . . . . . . December . . 37

QuickView, using in FCP . . . . . . September . . 17

reel IDs, changing . . . . . . September . . 20
RGB Parade scope . . . . . . August . . . . 10

Soundtrack Pro
audio cleanup . . . . . . October . . . . 14
external interfaces . . . . . . October . . . . 19
filters to improve mixes . . . November . . . . 29
Limiter filter . . . . . . July . . . . 25
Match EQ filter . . . . . . December . . . . 21
mixing . . . . . . August . . . . 25
opening projects . . . . . . November . . . . 36
shortcuts shared with FCP . . . . . . October . . . . 25

Spencer, Mark
"FCP Third-Party Plug-ins" (free) . . . . June . . . . 16
"FCP Third-Party Plug-ins" (paid) . . . . July . . . . 19
"FxPlug Filters in FCP 5.1.2” . . . . October . . . . 10
“Parameter Behaviors” . . . . . . December . . . . 5
“Particles in Motion” . . . . . . November . . . . 6

tapeless workflow
shooting . . . . . . July . . . . 6
workflow . . . . . . June . . . . 7

Tomchak, Thomas
"Export Multi-Track QuickTime Movies” . . November . . . . 37

trashing Final Cut Pro preferences . . . . . . December . . . . 20
trimming
real-time . . . . . . August . . . . 6
shortcuts . . . . . . August . . . . 9

Van Hurkman, Alexis
"Fixing Skin Tone Problems” . . . . July . . . . 13
"Improving Contrast” . . . . September . . . . 21
"Let’s Have a Parade” . . . . August . . . . 10
"Masked Color Corrections” . . . . October . . . . 36
“Real-Time Scopes in FCP 5.1.2” . . . . October . . . . 11

video scopes
Histogram . . . . . . September . . . . 22
problems with . . . . . . June . . . . . 29
real-time in FCP 5.1.2 . . . . . . October . . . . 11
understanding . . . . . . June . . . . . 24
using the RGB Parade scope . . . . . . August . . . . 10

video tutorials
“Four Quick Keyframe Effects” . . . . July . . . . 24
“FxPlug Filters in FCP 5.1.2” . . . . October . . . . 10
“Improve Your Capture Techniques” . . . . September . . . . 41
“Real-Time Scopes in FCP 5.1.2” . . . . October . . . . 12
“Repairing Your Audio” . . . . August . . . . 30
“STP: Channel EQ Filter” . . . . November . . . . 34
“STP: Fat EQ Filter” . . . . November . . . . 32
“STP: Limiter Filter” . . . . November . . . . 31
“STP: Match EQ Filter” . . . . December . . . . 22
“STP: Telephone Audio Effect” . . . . November . . . . 35
“Troubleshooting Your Final Cut System”. . June . . . . 23

“Wishes for the New Year” . . . . December . . . . 9
Wolsky, Tom
“Mystery of Auto-Select Buttons” . . . . June . . . . 30
“Real-Time Trimming” . . . . August . . . . 6
Apple Pro Training Series: 
Compressor
Quick-Reference Guide

Indispensable guide for video editors who need to duplicate and deliver content for multiple formats

- Shows the reader how to deliver video content to a wide variety of media including the Web, DVD, and video iPods.
- Compact guide is packed with timesaving tricks for repetitive tasks.
- The only book available on this little understood, but widely used Apple digital video software.

Author Bios

Award-winning writer, producer, and director Brian Gary creates a wide array of content for television, theatrical release, and the Web. Gary’s education includes the Actors Studio MFA program in New York City and he heads Flying Chaucer Films LLC in Los Angeles and Flying Chaucer Productions LLC in New Orleans. He is an accomplished editor who tours globally, speaking to audiences of Final Cut Pro editors.

Save 35% on this title today!
Simply go to www.peachpit.com and type in coupon code PZ-43AA-APLB at checkout.
The Apple Pro Training Series
The best way to learn Apple’s professional digital video software

Praise for Apple Pro Training books

Final Cut Pro
It is, in fact, one of the most thorough and consistently clear technical tutorials of any sort we’ve seen.
—Ric Getter, MacDirectory Magazine

Motion
The book is both comprehensive and fun, providing you with a myriad of insights, dozens of dazzling techniques, and useful tools that will certainly abbreviate your learning curve.
—Steve Douglas, KenStone.com

DVD Studio Pro
This book is quite possibly the only book you will need to master DVD authoring with DVD Studio Pro.
—Alex Alexzander, CreativeCOW.net

Logic Pro
It will give you an extra edge on the program as well as really cool tips and tricks on how to make your music recording experience more rewarding.
—Manuel Fernandez, www.maccompanion.com

GarageBand
This book is one of the best tutorial texts we’ve ever reviewed... Stop what you’re doing, buy this book, disconnect the phone and cable modem, and spend a weekend going from a novice to experienced GarageBand user. Highest recommendation, at 5 out of 5.
—John “Nemo” Nemerovski, MyMac.com

Save 35% on all Apple Pro Training titles!
Simply go to www.peachpit.com/applebooklet and type in the coupon code PZ-43AA-APLB at checkout!